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Complete Internet Guide For Beginners

Are you New to the Internet World ?

If you had just enter into the world of internet and don't know anything regarding Internet, you may going to face a
lot of problems. So, learn the basic aspects of Internet World. Our simple and easy to learn tutorial will help you a lot.

•

What is the Internet?

•

History of Internet.

•

How Internet Works.

•

SERVICES of Internet.

•

Security in the Network.

•

Launching Personal WebSite.

•

Multimedia in the Web

•

WebBrowser

•

Search Engines

Internet
What is the Internet?
Internet is the network of networks.
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It is a network of computers communicating with each other over fiber optic cables, telephone lines, satellite links and
other media.

Technically speaking, the internet is a network formed by the co-operative interconnection of various
computing networks. In fact, the word Internet was coined from the words "interconnection" and

"network".
On October 24, 1995, the Federal Networking Council (FNC) unanimously passed a resolution for defining the term
"Internet."

This definition was developed after consulting the leaders of the Internet and Intellectual Property Rights (IPR)
Communities.

The resolution was as follows:

"The Federal Networking Council (FNC) agrees that the following language reflects our definition of the term
"Internet."

"Internet" refers to the global information system that -

(i) is logically linked together by a globally unique address space, based on the Internet Protocol (IP) or its subsequent
extensions/follow-ons;

(ii) is able to support communications using the Transmission Control Protocol/Internet Protocol (TCP/IP) suite or its
subsequent extensions/follow-ons, and/or other IP-compatible protocols; and

(iii) provides, uses or makes accessible, either publicly or privately, high level services layered on the communications
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and related infrastructure described herein.

The Internet is a unique phenomenon in the world of computers and communication.

It has brought about a world-wide revolution by facilitating the exchange of ideas and information. The Internet is
becoming a fundamental part of our communication environment. It is something that affects everybody - be it a
student, a business person, a teacher, or a housewife. It'll affect your way of working, your way of playing, and
ultimately the way you live.

Internet is

An ocean of information
The most effective medium of communication and collaboration covering the complete globe.
Hundreds of libraries and archives of information at your fingertips
A world wide support group for any problem
An unlimited commercial opportunity
A window to the entire world

Internet Key concept

The main concept behind the Internet is that it was not designed for just one application.

It’s a general infrastructure on which new applications can be conceived, whenever required. This has been proved by
the emergence of the World Wide Web. The general-purpose nature of this service makes this possible.
The size of Internet
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The Internet is growing at a much faster rate than you have ever imagined. Every 30 minutes, a new network is connected to the Internet.

The concept of a global village is coming true, thanks to the Internet. All the distance barriers are diminished to zero, bringing the entire world
a mouse-click away.

Who runs the Internet? Who pays for the Internet?
These are two common questions that usually haunt our minds.

Well, the fact is that no one really runs the Internet as a whole. Each individual network is run by the owner of that
network. Each user owns a slice of the Internet. There are some regulatory bodies that define certain rules and
regulations for using Internet, but these bodies do not actually run the entire Internet.

And, as far as the payment side is concerned, everyone pays his/her own bill for using the Internet, similar to paying
our phone bills. The Internet bill depends on the volume of data and the type of access required.

Who owns the internet?
The Internet is not owned by any particular agency.
Every person who gets connected to the internet owns a slice of Internet.

The Internet is not funded by a single person, service, corporation, university or government.
There is no central administrative body to the Internet.
Internet is managed by all of us.
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History
Internet was initially formed, in 1969, by connecting various networks of the US Department of Defense, US
Universities and Research Organizations. It was called the ARPANET (Advanced Research Projects
Agency of the United States Department of Defense) and at that point in time, it connected only four sites.

The Internet has revolutionized the computer and communications world like nothing before.

The invention of the telegraph, telephone, radio, and computer, set the stage for this unprecedented integration of capabilities.
The Internet is a world-wide broadcasting capability, a mechanism for information dissemination, and a medium for collaboration
and interaction between individuals and their computers, all in one.

The Internet is like a vast transportation system for data. The system includes and connects local, regional, national, and
international networks

The Internet represents one of the most successful examples of the benefits of sustained investment and commitment to research
and development of information infrastructure.

Let us understand in brief, the history of Internet, right from the beginning.

1950s
1957
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USSR launches Sputnik, the first artificial earth satellite. In response, US forms the Advanced Research Projects Agency
(ARPA), within the Department of Defense (DoD), to establish US lead in science and technology, applicable to the military.

1961
First paper on packet-switching (PS) theory

1962
J.C.R. Licklider & W. Clark, MIT: "On-Line Man Computer Communication" (August 1962)

Galactic Network concept encompassing distributed social interactions

Paul Baran, RAND: "On Distributed Communications Networks"

Packet-switching networks were suggested; no single outage point

RAND Paul Baran, of the RAND Corporation (a government agency), was commissioned by the U.S. Air Force to do a study on
how it could maintain its command and control over its missiles and bombers, after a nuclear attack. This was a military research
network that could survive a nuclear strike. It was decentralised so that if any locations (cities) in the U.S. were attacked, the
military could still have control of nuclear arms for a counter-attack.

Baran's finished document described several ways to accomplish this. His final proposal was a packet switched network.

"Packet switching is the breaking down of data into datagrams or packets that are labelled to indicate the origin and the
destination of the information and the forwarding of these packets from one computer to another computer, until the information
arrives at its final destination computer. This was crucial to the realisation of a computer network. If packets are lost at any given
point, the message can be resent by the originator." Backbones: None - Hosts: None"
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1965
ARPA sponsors study on "co-operative network of time-sharing computers"

1966
First ARPANET plan

1967
Plan presented for a packet-switching network

First design paper on ARPANET published by Lawrence G. Roberts

1968
Packet Switched network presented to the Advanced Research Projects Agency (ARPA)

The work for ARPANET started.

1969
The ARPANET was constructed, linking four nodes: University of California at Los Angeles, SRI (in Stanford), University of
California at Santa Barbara, and University of Utah. The network was wired together via 50 Kbps circuits.

1970s
Store-and-forward networks in place
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Electronic mail technology emerged.

1970
ALOHAnet developed by Norman Abrahamson, Univ. of Hawaii connected to the ARPANET in 1972

ARPANET hosts start using Network Control Protocol (NCP).

1971
The number of nodes for ARPANET became 15, along with 23 hosts:

E-mail program invented to send messages across a distributed network.

1972
E-mail utilities are developed to list, selectively read, forward, and respond to messages.

ARPANET between 40 machines demonstrated.

Inter Networking Working Group (INWG) created to address the need for establishing agreed upon protocols.

The Advanced Research Projects Agency (ARPA) was renamed as Defense Advanced Research Projects Agency (or DARPA).

1973
ARPANET crossed the border of United States and reached London

Outlines idea of Ethernet emerged

Basic Internet ideas were developed
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Network Voice Protocol (NVP) specification (RFC 741) and implementation enabling conference calls over ARPANET. (:bb1:)

Development began on the protocol, later to be called TCP/IP. This new protocol was to allow diverse computer networks to
interconnect and communicate with each other.

1974
Development of TCP/IP in process

BBN opens Telnet, the first public packet data service (a commercial version of ARPANET) (:sk2:)

The term Internet is coined by Vint Cerf and Bob Kahn, in paper on Transmission Control Protocol.

1976
The Ethernet used coaxial cables to move data extremely fast. This was a crucial component to the development of LANs.

Commercial satellite is used to establish a link between USA and Europe.

The Department of Defence began to experiment with the TCP/IP protocol and soon decided to use it on ARPANET.

1977
Univ. of Wisconsin provided electronic mail facility to over 100 researchers in computer science

First demonstration of ARPANET/Packet Radio Net/SATNET operation of Internet protocols with BBN-

1979
USENET established
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ARPA establishes the Internet Configuration Control Board (ICCB)

Packet Radio Network (PRNET) experiment starts with DARPA funding. Most communications take place between mobile vans.
ARPANET connection via SRI.

1980s
1981
BITNET (Because It's Time Network" established)

CSNET (Computer Science Network) built by a collaboration of computer scientists and Univ. of Delaware, Purdue Univ., Univ. of
Wisconsin, RAND Corporation and BBN, through seed money granted by NSF, to provide networking services (especially email)
to university scientists with no access to ARPANET.

Vinton Cerf proposed a plan for an inter-network connection between CSNET and the ARPANET. Backbones: 50Kbps
ARPANET, 56Kbps CSNET, plus satellite and radio connections - Hosts: 213

Photograph of Vinton Cerf .......

1982
DCA and ARPA establish the Transmission Control Protocol (TCP) and Internet Protocol (IP), as the protocol suite, commonly
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known as TCP/IP, for ARPANET.

This leads to one of the first definitions of the Internet as "a connected set of networks, specifically those using TCP/IP, and
"Internet" as connected TCP/IP Internet.

DoD (Department of Defence) declares TCP/IP suite to be standard for DoD.

EUnet (European UNIX Network) is created to provide e-mail and USENET services.

External Gateway Protocol (RFC 827) specification. EGP is used for gateways between networks.

1983
Name server developed at Univ. of Wisconsin, no longer requiring users to know the exact path to other systems.

CSNET/ ARPANET gateway put in place

ARPANET split into ARPANET and MILNET; the latter became integrated with the Defense Data Network created the previous
year.

Desktop workstations come into being, many with Berkeley UNIX, which includes IP networking software.

Networking needs a switch from having a single, large time sharing computer connected to the Internet at each site, to
connecting the entire local networks.

Internet Activities Board (IAB) established, replacing ICCB

EARN (European Academic and Research Network) established.

TCP/IP replaces NCP entirely.
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Domain Name System (DNS) created.

1984
Domain Name System (DNS) introduced.

JUNET (Japan Unix Network) established using UUCP.

JANET (Joint Academic Network) established in the UK, using the Colored Book protocols; previously SERCnet.

1985
Information Sciences Institute (ISI) at USC is given responsibility for DNS root management by DCA, and SRI for DNS NIC
registrations

Symbolics.com is assigned on the 15th of March to become the first registered domain. Other firsts: cmu.edu, purdue.edu,
rice.edu, ucla.edu (April); css.gov (June); mitre.org, .uk (July)

Hundred years to the day of the last spike being driven on the cross-Canada railroad, the last Canadian university is connected
to NetNorth in a one year effort to have coast-to-coast connectivity. (:kf1:)

The National Science Foundation began deploying its new T1 lines, which would be finished by 1988.

1986
Internet Engineering Task Force (IETF) and Internet Research Task Force (IRTF) comes into existence under the IAB.

Network News Transfer Protocol (NNTP) designed to enhance UseNet news performance over TCP/IP.

Mails Exchanger (MX) records developed by Craig Partridge allow non-IP network hosts to have domain addresses.
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USENET name changed to News groups.

1987
NSF signs a co-operative agreement to manage the NSFNET backbone with Merit Network, Inc. (IBM and MCI involvement was
through an agreement with Merit). Merit, IBM, and MCI later founded ANS.

UUNET is founded with Usenix funds to provide commercial UUCP and Usenet access. Originally an experiment by Rick Adams
and Mike O'Dell

E-mail link established between Germany and China

1988
Internet worm burrows through the Net, affecting ~6,000 of the 60,000 hosts on the Internet

CERT (Computer Emergency Response Team) formed by DARPA in response to the needs exhibited during the Morris worm
incident. The worm is the only advisory issued this year.

NSFNET backbone upgraded to T1 (1.544Mbps)

Internet Relay Chat (IRC) developed by Jarkko Oikarinen

Countries connecting to NSFNET: Canada (CA), Denmark (DK), Finland (FI), France (FR), Iceland (IS), Norway (NO), Sweden
(SE)

Soon after the completion of the T1 NSFNET backbone, traffic increased so quickly that plans immediately began on upgrading
the network again.

The concept of the T3 carrier emerged
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1989
Number of hosts breaks 100,000

RIPE (Reseaux IP Europeans) formed (by European service providers) to ensure the necessary administrative and technical coordination to allow the operation of the pan-European IP Network.

First relays between a commercial electronic mail carrier and the Internet: MCI Mail through the Corporation for the National
Research Initiative (CNRI), and CompuServe through Ohio State Univ.

Corporation for Research and Education Networking (CREN) is formed by merging CSNET into BITNET

Countries connecting to NSFNET: Australia (AU), Germany (DE), Israel (IL), Italy (IT), Japan (JP), Mexico (MX), Netherlands
(NL), New Zealand (NZ), Puerto Rico (PR), United Kingdom (UK)

1990s
1990
ARPANET ceases to exist

Archie released

The World comes on-line (world.std.com), becoming the first commercial provider of Internet dial-up access

ISO Development Environment (ISODE) developed to provide an approach for OSI migration for the DoD. ISODE software
allows OSI application to operate over TCP/IP

The first remotely operated machine to be hooked up to the Internet, the Internet Toaster by John Romkey, (controlled via
SNMP) makes its debut at Interop.
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Countries connecting to NSFNET: Argentina (AR), Austria (AT), Belgium (BE), Brazil (BR), Chile (CL), Greece (GR), India(IN),
Ireland (IE), Korea (KR), Spain (ES), Switzerland (CH)

T3 lines were being constructed,

A hypertext system emerged to provide efficient information access to the members of the international high-energy physics
community.

1991
Wide Area Information Servers (WAIS), invented by Brewster Kahle, released by Thinking Machines Corporation

Gopher released by Paul Lindner and Mark P. McCahill from the Univ. of Minnesota

World-Wide Web (WWW) released by CERN;

US High Performance Computing Act (Gore 1) establishes the National Research and Education Network (NREN)

1992
Internet Society (ISOC) is chartered

RIPE Network Coordination Center (NCC) created in April, to provide address registration and co-ordination services to the
European Internet community.

IAB reconstituted as the Internet Architecture Board and becomes part of the Internet Society

Veronica, a Gopherspace search tool, is released by Univ. of Nevada

World Bank comes on-line
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Japan's first ISP, Internet Initiative Japan (IIJ), is formed by Koichi Suzuki

The term "Surfing the Internet" is coined by Jean Armour Polly

Countries connecting to NSFNET: Antarctica (AQ), Cameroon (CM), Cyprus (CY), Ecuador (EC), Estonia (EE), Kuwait (KW),
Latvia (LV), Luxembourg (LU), Malaysia (MY), Slovakia (SK), Slovenia (SI), Thailand (TH), Venezuela (VE)

NSFNET backbone upgraded to T3 (44.736Mbps)Backbones: 45Mbps (T3) NSFNET, private interconnected backbones
consisting mainly of 56Kbps, 1.544Mbps, plus satellite and radio connections - Hosts: 1,136,000

1993
InterNIC created by NSF to provide specific Internet services

Worms of a new kind find their way around the Net - WWW Worms (W4), joined by Spiders, Wanderers, Crawlers, and Snakes

Internet Talk Radio begins broadcasting

United Nations (UN) comes on-line

Businesses and media really take notice of the Internet .
Mosaic takes the Internet by storm; WWW proliferates at a 341,634% annual growth rate of service traffic. Gopher's growth is
997%.

Countries connecting to NSFNET: Bulgaria (BG), Costa Rica (CR), Egypt (EG), Fiji (FJ), Ghana (GH), Guam (GU), Indonesia
(ID), Kazakhstan (KZ), Kenya (KE), Liechtenstein (LI), Peru (PE), Romania (RO), Russian Federation (RU), Turkey (TR), Ukraine
(UA), UAE (AE), US Virgin Islands (VI)

Marc Andreessen and NCSA and the University of Illinois develop a graphical user interface to the WWW, called "Mosaic for X".
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1994
ARPANET/Internet celebrates 25th anniversary

Communities begin to be wired up directly to the Internet (Lexington and Cambridge, Mass., USA)

Shopping malls arrive on the Internet

Vladimir Levin of St. Petersburg, Russia, is the first publicly known Internet bank robber, stealing millions of dollars from Citibank
between June and August.

The National Institute for Standards and Technology (NIST) suggests that GOSIP should incorporate TCP/IP and drop the "OSIonly" requirement

NSFNET traffic passes 10 trillion bytes/month

Yes, it's true - you can now order pizza from the Hut on-line

First Virtual, the first cyberbank, opens up for business

Countries connecting to NSFNET: Algeria (DZ), Armenia (AM), Bermuda (BM), Burkina Faso (BF), China (CN), Colombia (CO),
Jamaica (JM), Lebanon (LB), Lithuania (LT), Macau (MO), Morocco (MA), New Caledonia, Nicaragua (NI), Niger (NE), Panama
(PA), Philippines (PH), Senegal (SN), Sri Lanka (LK), Swaziland (SZ), Uruguay (UY), Uzbekistan (UZ)

ATM (Asynchronous Transmission Mode, 145Mbps) backbone is installed on NSFNET.

1995
NSFNET reverts back to a research network. Main US backbone. The traffic now routed through interconnected network
providers
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Hong Kong police disconnect all but one of the colony's Internet providers in search of a hacker. 10,000 people are left without
Net access.

RealAudio, an audio streaming technology, lets the Net hear in near real-time

Radio HK, the first commercial 24 hr., Internet-only radio station starts broadcasting

WWW surpasses ftp-data in March as the service with greatest traffic on NSFNET based on packet count, and in April based on
byte count

Traditional on-line dial-up systems (Compuserve, America On-line, Prodigy) begin to provide Internet access

A number of Net related companies go public, with Netscape leading the pack with the 3rd largest ever NASDAQ IPO share
value (9 August)

The first official Internet wiretap was successful in helping the Secret Service and Drug Enforcement Agency (DEA) apprehend
three individuals who were illegally manufacturing and selling cell phone cloning equipment and electronic devices

Operation Home Front connects, for the first time, soldiers in the field with their families back home via the Internet.

Richard White becomes the first person to be declared a munition, under the USA's arms export control laws, because of an RSA
file security encryption program emblazoned on his arm

Technologies of the Year: WWW Search engines

Emerging Technologies: Mobile code (JAVA, JAVAscript), Virtual environments (VRML), Collaborative tools

1996
Internet phones catch the attention of US telecommunication companies who ask the US Congress to ban the technology
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(which has been around for years)

Malaysian Prime Minister, Mahathir Mohammed, PLO Leader, Yasser Arafat, and Philippine President, Fidel Rhamos meet for
ten minutes in an on-line interactive chat session on 17 January.

The controversial US Communications Decency Act (CDA) becomes law in the US, in order to prohibit distribution of indecent
materials over the Net. A few months later a three-judge panel imposes an injunction against its enforcement. Supreme Court
unanimously rules most of it unconstitutional in 1997.

9,272 organisations find themselves unlisted after the InterNIC drops their name service, as a result of not having paid their
domain name fee

Various ISPs suffer extended service outages, bringing into question whether they will be able to handle the growing number of
users. AOL (19 hours), Netcom (13 hours), AT&T WorldNet (28 hours - e-mail only)

New York’s' Public Access Networks Corp. (PANIX) is shut down after repeated SYN attacks by a cracker, using methods
outlined in a hacker magazine (2600)

Various US Government sites are hacked into and their content changed, including CIA, Department of Justice, Air Force

MCI upgrades Internet backbone adding 13,000 ports, bringing the effective speed from 155Mbps to 622Mbps.

The Internet Ad Hoc Committee announces plans to add 7 new generic Top Level Domains; firm, store,.web, .arts,.rec, .info,
nom. The IAHC plan also calls for a competing group of domain registrars worldwide.

A malicious cancelbot is released on USENET, wiping out more than 25,000 messages.

The WWW browser war, fought primarily between Netscape and Microsoft, has rushed in a new age in software development,
whereby new releases are made quarterly with the help of Internet users eager to test upcoming (beta) versions.
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Restrictions on the Internet use, around the world.

China: requires users and ISPs to register with the police

Germany: cuts off access to some newsgroups carried on CompuServe

Saudi Arabia: confines Internet access to universities and hospitals

Singapore: requires political and religious content providers to register with the state

New Zealand: classifies computer disks as "publications" that can be censored and seized

Technologies of the Year: Search engines, JAVA, Internet Phone

Emerging Technologies: Virtual environments (VRML), Collaborative tools, Internet appliance (Network Computer)

Currently the Internet Society, the group that controls the INTERNET, is trying to figure out new TCP/IP to be able to have billions
of addresses, rather than the limited system of today. The problem arose that it is not known how both the old and the new
addressing systems will be able to work at the same time during a transition period. Backbones: 145Mbps (ATM) NSFNET (now
private), private interconnected backbones consisting mainly of 56Kbps, 1.544Mbps, 45Mpbs, and 155Mpbs lines, plus satellite
and radio connections - Hosts: over 15,000,000, and growing rapidly.

1997
2000th RFC: "Internet Official Protocol Standards"

71,618 mailing lists registered at Liszt, a mailing list directory

The American Registry for Internet Numbers (ARIN) is established to handle administration and registration of IP numbers to the
geographical areas, currently handled by Network Solutions (InterNIC), starting March 1998.
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101,803 Name Servers in whois database

Technologies of the Year: Push, Multicasting

Emerging Technologies: Push, Streaming Media

1998
Internet users get to be judges in a performance by 12 world champion ice skaters on 27 March, marking the first time a
television sport shows outcome is determined by its viewers.

Electronic postal stamps become a reality, with the US Postal Service allowing stamps to be purchased and downloaded for
printing from the Web.
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The Basic Internet Protocol
The Internet uses TCP/IP protocol suite as network and transport layer protocol for providing various services. All the computers
on the internet communicate using this protocol .

TCP/IP
Acronym for Transmission Control Protocol over Internet Protocol. The TCP/IP suite is unique and is made up of non-proprietary
protocols. TCP/IP protocol suite consists of several other protocols, such as TCP, IP, ARP, SMTP, etc.

Domain Name System (DNS)

Every computer on the Internet is identified by a unique IP (Internet Protocol) address. This address is
assigned by an international organization InterNIC.
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IP addresses are 4-byte numbers. e.g., 38.254.83.6. Such addresses are difficult to remember. Therefore a
naming scheme called Domain Name System - DNS was designed. With DNS, we can specify the domain
name in English.

For example, a computer with an IP address 38.254.83.6 can have a domain name www.silverline.com,
which is much easier to remember.

DNS Server
On the Internet, a computer can have more than one domain name but only one IP address.

The DNS servers are computers on the Internet, which provide a service to map a computer's domain name to its IP
address.

Most services on the Internet use a DNS server to match the user-friendly domain name to the corresponding machine IP
address.

Provision of Services
Almost all services that are available on the Internet use client-server computing model. Each service on the Internet has three
basic components namely, Server software

Client software

Service protocol.

The server software implements a particular service while the client software allows a user to connect to the server that provides
the service.The client and server software communicate using the application layer protocol designed for that particular service.
This model is followed by almost all services available on the Internet.
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Internet Services
Some of the popular services available on the Internet are

Electronic Mail (E-mail)
File Transfer (FTP)
News Group
Gopher
World Wide Web (WWW)
Real-time Chat

Email:

E-mail, Electronic Mail, provides a one to one and one-to-many communication mechanism to send and receive textual
messages.

For example: Each user of E-mail service has an E-mail address like ajay@silverline.com.
An E-mail client program is used to compose and send the mail to the recipient address. This mail then goes to the
local mail server (local post office), which forwards the mail further to other mail servers until it reaches the recipient’s
mailbox.

Popular E-mail programs: Eudora, Netscape Mail, Pegasus mail.
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E-mail Protocols

There are two types of protocols used for sending/receiving E-mails:

SMTP: Simple Mail Transfer Protocol (SMTP) is the protocol that is designed to handle E-mails. SMTP is effective,
efficient and reliable and runs at the application layer of the ISO/OSI network model. SMTP handles communication
between servers

POP3: Post Office Protocol Version 3 takes care of sending the mail to the server and receiving the mail from the
server. The communication between the servers is through SMTP.
E-mail Attachments

Initially only textual messages were sent through e-mail, over a period of time, people felt the need for sending various
other types of information like images, software, spreadsheet documents, etc. along with the textual messages through
E-mail.

A standard called MIME (Multipurpose Internet Mail Extensions) was designed to enable different types of
information to be attached with e-mail messages.

FTP - File Transfer Protocol

File Transfer Protocol is a protocol that allows the user on one host to access and copy files to and from another host
over the Internet.

The file transfer or FTP service is used to exchange relatively large information.

This information can be in any file format.

***** Copyright © EQuestionAnswers.com *****

FTP supports various commands like LIST, CD, GET, PUT, etc. These commands allow the users to list, change
directories, get or transfer file to/from FTP server.

FTP Servers

There are many FTP servers on the Internet, which host various types of files like graphic images, technical/reference
articles, software programs and many more.

These files are usually organized in a directory hierarchy on the FTP server, based on the file category and have unique
names within that directory.

How FTP Works?

A user who is interested in downloading certain files, uses the FTP client program to connect to the FTP server using
the FTP protocol.

To enable a user to find a particular file name on these servers, a service called Archie was designed which indexes file
names located on popular FTP sites.

News Group

The news group works as a medium to share information and views on a certain topic.
There are many news servers on the Internet hosting different types of news groups.

The virtual network formed by all the news servers on the Internet is called UseNet.
How a News Group works?
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A server known as News server hosts the news groups. A user uses the News client to connect to the news server, e.g.,
forums.macromedia.com

The news group service uses NNTP protocol.
NNTP

The NNTP (Network News Transfer Protocol.) allows distribution, inquiry, retrieval and posting of news articles.

This protocol allows users to subscribe to a particular news group, post an item to a news group, list or view an item
posted by other users, etc.

Gopher
Gopher is a system used for organizing and displaying files on the Internet servers.

A Gopher server presents its contents as a hierarchical structured menu of file titles.

A user uses the Gopher client to access the gopher servers. The gopher server then presents the information in the form menus.
The items are presented as a single line title as against just a file name in FTP server.

All the Gopher servers on the Internet form a virtual network called Gopher Space.

Veronica and Jughead are the tools provided by Gopher to index the titles of files on the Gopher servers and to search for files in
Gopher Space

World Wide Web (WWW)
The World Wide Web, also referred to as, WWW, W3 or simply the Web, is the service on the Internet that started around 1993.

The WWW is a highly graphical collection of multimedia documents which use simple hypertext based navigation.
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What is on the Web?
Word Wide Web or W3 or simply the Web, is one of the popular application of the Internet.

Due to the WWW technology, the Internet is capable of conveying sounds, images and video clips. The attraction towards this
technology drew many people towards the Web. The popularity of the Internet grew exponentially, thanks to the Web.

The World Wide Web is a home to millions of Web sites, set up by businesses, agencies, institutions and individuals.

You name it and it's there on the Web. There are a very few things for which you will not find information on the Web.

What can you do on the web?

With the word wide web, you can take care of most of your work from you desk, either at home or at office.

WWW
•

Window of your company to the world
On the world wide web, you can display the services or product your company has to offer. Your company’s web site
having all the relevant information about the company and its services will now be available to the entire world. Anyone,
from any corner of the world, can visit you web site and find out information about the product and services that you
company offers.

•

Shopping Malls on the Web
Shop and buy instantly on the Web, at the sites of individual companies or through mall-like sites that connects you to
thousands of "on-line stores."

•

Banking from your desktop computer
Now no need to rush to the bank for getting your work done. The Web allows you to do your banking straight from your
computer, either at home or at office. You can find out your balance and other details of your account. You may transfer
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money to some other account. You can also find out details of other services that the bank has to offer.

•

Latest News
You need not wait for the morning paper in order to find out what's happening in the world. No need to switch on the
television or radio also. Internet has many news sites on the Web that are updated repeatedly throughout the day. So you
can get the latest news of the world events, sports, weather, and that too whenever you want it.

•

Reference Library
The Internet provides you with access to numerous reference materials, including the collections of many libraries,
research facilities, museums, and similar institutions. The World Wide Web acts as a friendly librarian who can help you
to search the required information You can find information which is as simple as the definition of a word or as complex
as the latest in scientific research.

And much more …

Shopping, banking and investing, news, and reference materials are just the tip of the iceberg. There's also plenty in the field of
entertainment and fun, obscure topics and eccentric interests.
Is the Internet and the Web the same thing?
The Internet and the World Wide Web are closely related, but

not the same.

Web is one of the services of the Internet.

•

The Internet is a decentralised global network of computers.

•

The Web is a collection of documents, or Web sites, that you can access via the Internet
and your Web browser. The Web comprises the vast majority of the content available
over the Internet.
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How does web work?
Web sites reside on computers called Internet servers. When you're connected to the Internet, your Web
browser can communicate with Internet servers, asking them to send to your computer, a copy of the
Web page you'd like to see. The URL you type or the hyperlink you click, tells your computer the
address of the web site.

WWW

Invented by CERN, Switzerland. World wide Web, WWW is a hypermedia based distributed information
system that allows users to create, edit and browse through hypertext documents.
Hypertext:
Hypertext is the text that points to other texts, which in turn may point to various other texts or documents. Hence it is an
interconnected web of textual information. On the Web, hypertext is easily recognizable as it is always underlined and of a
different color. Hypertext is a web of connected information where one text is linked to another text or document. Hypertext links
makes navigation easier on the Web.
For example, you are currently looking at one level of hypertext, where one text is pointing to another text.

Web Servers

WWW uses Web servers to host a variety of information. There are many Web servers on the Internet. An organization can have one or more
Web servers. This web server usually hosts information pertaining to a company and its products.

There are other generic Web servers that host reference documents, technical articles,shareware software, and much more.

The information stored on Web server is in HTML format.

HTML:
HyperText Markup Language is a meta- language that allows different types of information (including text, graphics, audio and
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video) to be presented in a unified way.

This language is used to "mark up" hypertext and hypermedia documents and store these documents on the Web server. These
documents can be transmitted and displayed upon request by the Web browser client.

Web Browsers

Web browsers connect users to the web server and also render HTML documents received from the server.

To retrieve information from a Web server, one needs to specify the URL (Uniform Resource Locator) - a standardized location of
a particular Internet resource.

The Web browser and Web server use HTTP (Hypertext Transport Protocol) protocol.

Some of the popular web browsers are: Netscape Navigator and Microsoft Internet Explorer.

URL
URL is an acronym for Uniform Resource Locator. As the name suggests, the URL specifies the location of a document on the
Internet. It consists of three parts namely protocol, domain name of the server, the directory path of the file.

Home Page
The default HTML document on any server is referred to as the Home Page.

The Home Page provides links to the information on the server. Some of these links may point to information located on other
Web servers on the Internet.

Home Pages allow users to seamlessly navigate information located anywhere on the Internet. They display all types of
information. The information could be a company profile or product information or may be a resume of an individual.
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Search Engines
The explosion of information on the Internet brought up the need for search engines, to search for desired information.

Search engines are programs that search among the database of the Internet sites or information.

A search engine works by sending out a spider to fetch as many documents as possible. Another program, called an indexer, then
reads these documents and creates an index based on the words contained in each document. The search engine uses a
proprietary algorithm to create the indices and returns meaningful results for a query.

Using a Search Engine

Most search engines are easy to use. Just follow these steps to use the search engine for the required information.

Get connected to the search engine by specifying the URL like http://www.yahoo.com
The search engine will ask for the search text
Specify the search text (key words on which you need information).
The search engines list the links to a number of sites on the web which contain the search text
Choose the relevant link to get the desired information.

Some popular search engines: Yahoo, Altavista, Infoseek

Real Time Chat

Real Time Chat
Internet Relay Chat (IRC) is the service on the Internet that allows people to communicate over the
Internet in real time. IRC allows one to one meetings, as well as many-to-many real-time chat.

IRC server hosts different channels or virtual chat rooms on various topics. People can join any of these
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chat rooms and participate in the discussion using the IRC client software.

Popular IRC client software: Pirch, MIRC, etc.

There are other multimedia real time communication tools like Cooltalk and NetMeeting which allow
users to have one-to-one meetings as well as arrange conferences using audio/video and textual
messages.

Web Chat

As WWW is getting more and more popular, many sites host web-based chats which can be accessed using a web
browser.

For example : http://www.chat.yahoo.com

Return to >>Main Menu

Internet and Security
The Internet connects us to various places all over the world. This fact poses the question of security, i.e. theft on private
communication or electronic commerce transactions on the Internet. Let us look at some technologies related to the security
issues over the Internet.

The Internet may feel like a place where you roam anonymously and privately, especially if you access it from your own home.
However, with every foray onto the Internet, your computer and other computers actively exchange information. So the question
arises as to how private and secure are these communications? What is the security of your data when you are on the Internet.

The security that your machine has, depends on the sites you visit and the options you select for your web browser, and the
features that your web browser provides.
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Security Mechanisms on the Internet
Some of the technologies related to security on the Internet are:

Secure Sockets Layer

Secure HTTP

Secure Electronic Transaction

Digital Certificate

Secure Sockets Layer

Secure Sockets Layer or SSL is a protocol developed by Netscape for transmitting private documents via the Internet.

SSL works by using a private key to encrypt data that is transferred over the SSL connection. SSL protocol is used to obtain
confidential user information, such as credit card numbers.

By convention, Web pages that require an SSL connection start with https: instead of http Secure Sockets Layer is a protocol for
transferring confidential documents over the Internet. Developed by Netscape, SSL provides security by using a private key to
encrypt the data that needs to be transmitted.

Return to >>Internet and Security

Secure HTTP

Another protocol for transmitting data safely over the World Wide Web is Secure HTTP (S-HTTP). SSL creates a secure
connection between a client and a server, over which any amount of data can be sent securely, whereas S-HTTP is designed for
transmitting only individual messages with total security. Secure HTTP is a protocol designed for the safe transmission of
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individual messages only.

Return to >>Internet and Security

Secure Electronic Transaction

Secure Electronic Transactions or SET, is a new standard that enables secure credit card transactions on the Internet. Nearly all
the major players in the electronic commerce arena, including Microsoft, Netscape, Visa, and MasterCard, have endorsed SET.
Secure Electronic Transaction allows credit card transactions to take place securely over the Internet. Microsoft, Visa, Netscape
and MasterCard have approved this standard.
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Digital Certificate

Digital Certificate is an attachment to an electronic message, used for security purposes. The most common use of a digital
certificate is to verify that a user sending a message is whom he or she claims to be, and to provide the receiver with the means
to encode a reply. A Digital Certificate usually uses public-key cryptography.

An individual wishing to send an encrypted message, applies for a digital certificate from a Certificate Authority (CA). The CA
issues an encrypted digital certificate containing the applicant's public key and a variety of other identification information. The CA
makes its own public-key readily available through print publicity, or perhaps on the Internet. The recipient of an encrypted
message uses the CA's public- key to decode the digital certificate attached to the message, verifies it as issued by the CA and
then obtains the sender's public-key and identification information held within the certificate. With this information, the recipient
can send an encrypted reply.

The most widely used standard for digital certificates is X.509.

Digital Certificate is an attachment to an E-mail, which verifies the identity of the sender and allows the receiver to send a similar

***** Copyright © EQuestionAnswers.com *****

encoded reply. The encryption is done using a public-key.

Return to >>Internet and Security

Internet and Banking - Banks on the Web
More and more banks around the world have started home banking services, i.e. banking over the Internet.

Internet banking is of course convenient, which every customer would love to have.

Most banks with on-line services allow you to do the following:

•

Check your account balances.

•

Transfer funds between your accounts.

•

Pay your bills on-line.

Some even let you do these things:

•

Apply for loans.

•

Download information about your accounts.

•

Trade stocks or mutual funds, electronically.

For customers, on-line banking means convenience. You can bank on-line 24 hours a day, 7 days a week. Right now, the
banks are charging fees for on-line services. In the long run, on-line banking should be less expensive than other forms of
banking, for banks as well as for customers.

Is your bank on-line?

Check with your bank to find out which on-line services it offers. Some banks refer to on-line banking as "PC banking," "home
banking, "electronic banking," or "Internet banking". If your bank is not on-line, may be you can insist that they should give you online facilities.
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Banking Security
Is on-line banking secure?

This is a million dollar question that ‘is your money in the on-line bank secure?’. Can some computer nerd do something to hack
your bank account?

Well, this is not exactly true. The on-line banking uses encryption techniques to protect your personal financial information and
resources. This means that before your Web browser sends on-line banking information over the Internet, it turns that information
into a code. When the information reaches your bank's computers, it gets decoded.

So if anyone were to intercept your information while it's between you and your bank, the information would be completely
unreadable. As long as you keep your on-line banking password private, no one else has access to your financial information.

You can select the security option using your web browser. You can make the security of your browser high or low, depending on
the requirements.

For details on the security options of your browser, check its Help files.

Viruses
Beware of Viruses that you may receive from the Internet. Viruses can attack your computer when you download files or even
when you receive e-mails.

To protect your computer from viruses on the Internet, don't download files from sources that you don't know are safe. Viruses are
usually hidden in programs and activated when the programs run. They also can be attached to certain other types of executable
files, such as special-action Web files and video files.

Generally, when you're about to download a type of file that could contain a virus, your browser will display a warning and ask
whether you want to open the file, or save it to disk. If you're confident that the file comes from a trustworthy source, you may
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want to open it. If you're not sure, you may want to cancel your download.

Another way to verify the identity of a site is to check whether it has a Web site certificate, naming the site's originator. With
Microsoft® Internet Explorer version 4.0, you can check a Web page's certificate by right-clicking on the page, clicking Properties,
and then clicking Certificates.

The best precaution you can take is to use an anti virus program.

There are many anti virus programs that can scan your computer for viruses, inoculate

What are Cookies?
A cookie is a small amount of information stored on your computer by a Web site - information that your Web browser
sends back to the site, whenever you visit it again. Usually the cookie is designed to remind the site of information about you,
such as your password for the site or the customised back ground colour you choose. This is to simplify your browsing.

Cookies are common and usually harmless. They can't be used to take information about you or your computer that you have
not provided. But, they can be used by certain services to create a profile of your interests, based on the sites you visit. Then,
advertisements on participating sites can be customised for you.

Privacy
Any Web site you visit, can tell who and where your Internet service provider is, what site you last visited, what Web browser
you're using, and what you do while you're at the site.

By asking you to register, a site can collect additional information from you, such as your name, e-mail address, postal address,
income level, and interests. However, it's up to you whether to provide this or not.
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Are you listed on the Web?

If you're listed in the white pages of the telephone book, your name, address, and telephone number are probably in databases,
on the World Wide Web, available for others to search. For example, try looking yourself up in the Yahoo! White Pages or the
InfoSpace directory. You may be able to find out if your name appears elsewhere, by searching for your name, using a search
engine.

Are your e-mails private and secure?

Theoretically speaking, the system administrators who are in-charge of the server, can read your e-mail if they want to. But, so
many e-mail messages are sent each day that it is unlikely that any particular message would be read. Still, the employers or law
enforcement authorities have the right to monitor e-mail. So, it's a good idea not to disclose any private information in the email.

Return to >>Main Menu

Launching Personal WebSite
Steps to create your web page
As you know, millions of web sites exist on the World Wide Web. You must be wondering how to have your own site,
wherein you can display information of your company or even have your own personal information.

Well, to establish a World Wide Web site, the following four components need to be considered:

•

the connection

•

server hardware

•

server software
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•

content

If you plan to conduct financial transactions through your Web site, consider the Web server software that supports
encryption to secure these transactions.

You may decide whether to do the work involved in each component, or outsource all or part of the work. Usually the
connection, the server hardware and the software is taken care by either your Internet service providers or the company
that is hosting your page on the server. What you really need to take care of is the content. The content will project the
image of your company to the entire world.

To create your own pages, just follow the following steps.

Step 1: Decide on the content of the web page
Content means whatever information and services you would like to have on your site. Your Web page can give access
to databases, software scripts, and additional files. You can also offer interactive options, such as a search capability
and order forms.

Step 2: Develop the web page
Decide on the graphics that will go on your web page.
Develop the graphic images in the format that web supports (usually *.gif or *.jpg)
Once the text, graphics and other media objects are ready, develop the page using html language or by using a software
package like Microsoft FrontPage or Netscape Composer.

Step 3: Test the web site before making it active on the web

It is very important to test all the web pages before you make them active on the Internet. Check for the content,
accuracy of graphics, typographical errors, your address and phone numbers and the hyperlinks.

Step 4 : Register you page with InterNic
Big companies get registered with InterNic and obtain their own domain name. For example www.silverline.com, where
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Silverline is the company’s name.

Step 5 : Promote your web site
Once your Web site is set up, you must promote it to make it visible to others. First register your site with different
search engines. So if anyone searches for the services or products you offer, your web site appears as the search
results. Get your web site listed in several newsgroups and mailing lists. Inform all your business clients and associates
of your URL address through business cards, literature, and business meetings.

A good way for people to find your site is on the recommendation of other sites. Therefore, invite your suppliers, peers,
and industry specific site visitors to place a link on their site to yours. This is the technological version of "word of
mouth" advertising.

Step 6 : Enrich the content of your site
To make an efficient use of the site you have, attract attention of the visitors. If you want visitors to "PAY" attention to
your site, then in return you must "GIVE’ something to the visitors for paying this attention. From the web site, you can
give additional interesting content to your target audience. Offer something free from your site, it could be free tickets,
free software or something else.

Step 7: Update you site regularly
It is important to update information on your site frequently. The frequency of updating depends on the company.
Remember, visitors do not re-visit sites that don’t change for months at a time.

Step 8: Advertise your page
You have to pay for advertising your sites on other sites. Decide on your budget and target audience, before you decide
where to advertise your site.

Step 9: Personal web sites or web sites for small companies
If you wish to put up your personal page or if you are working for a very small company, who would like to have
presence on the web free of charge then search for the sites which offer you free hosting of your web pages. Some web
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sites host your page, free of cost. Actually, they advertise their sites through your page. These sites are good if you
want to put personal information on the web. (tripod, geocities, rediffonthenet, etc.)

Tools used for developing web page
The web site developers can use any one of the following or a combination of the following languages. Here, we give a
brief information about these tools/languages.

HTML
HyperText Markup Language is a programming language used to build Web sites. It contains standard codes, or tags, that
determine how a Web page looks, when your browser displays it. For example, tags are used to create headings, paragraphs,
and lists. HTML tags also make possible the hyperlinks that connect information on the World Wide Web. With help from
programs like the Microsoft® FrontPage® 98 or Netscape composer Web site creation and management tool, you can create
Web sites without knowing HTML. But, it may be helpful for you to understand the basics of HTML.

DHTML
Dynamic HTML, an extension of HTML, gives you more control over the appearance and position of everything on your Web
page. It is considered dynamic, because it gives you a way to include elements on your page that downloads to a user's Web
browser, along with the page. but it doesn't become visible until the user interacts with them. This means that when the user
interacts with the elements, they activate, without requiring anything of your Web site's server.

XML
XML or Extensible Markup language is a data format that makes it easy to define types of documents, author and manage
documents, and share them over the Web. It's an abbreviated version of Standard Generalized Markup Language (SGML), the
mother of all languages. So it's easier to use, understand, and write programs for.

ActiveX®
A Microsoft technology that facilitates interoperability, or sharing, among applications. ActiveX controls (or component
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applications) let you embed smart objects in the site. Once a user's browser downloads an ActiveX control from a site, the control
remains on the user's computer. So, when the user visits another site, (or another page on your site) using the same control, it
doesn't have to be download again.

Java
Java is an object-oriented programming language developed by Sun Microsystems to create applets, or programs that can be
distributed as attachments to Web documents. An applet can be included in an HTML page, much as an image can be included.
When you use a Java-capable browser to view a page containing a Java applet, the applet's code is transferred to your system,
and executed by the browser.

Scripting
A programming shortcut that gives non technical users, a way to create richer content on their computers, and gives programmers
a quick way to create simple applications. Scripting enables you to set and store variables, and work with data in your HTML
code. Many Web sites now employ scripting, to check the browser a user is running, validate input, work with applets or controls,
and communicate to the user.

Get More Information in >>Complete Reference to Personal WebSite Building
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Multimedia in the Web
Can one have graphics, animation, audio or video (in short multimedia) on the web site?

Oh!

- YES - now you can have all the media combined together on the web to ensure most effective

communication.
Initially, the web pages had only textual messages. Later on, with new protocols and advances in the networking
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technology, and increased bandwidth, not only allowed incorporation of graphics, but also audio and video over the net.

Now the Web will soon become a gateway to multimedia experiences - where you can view enhanced television
programs, hold on-line meetings with family and colleagues, listen to audio clips of CDs at on-line music stores, and
much more. You can even battle remote computer-game opponents, at venues like the Internet Gaming Zone.

Software required to use multimedia on web
You need some special software to play audio and video clippings over the net. The new concept of streaming media needs one
of the following software:

NetShow Server
The Microsoft® NetShow™ server allows you to see and hear live and recorded broadcasts, such as concerts and breaking news
over the Web. And streaming technology allows you to see and hear the information as it arrives, instead of having to wait for the
entire file to download.

Liquid Motion
The Microsoft® Liquid Motion™ Web multimedia and animation tool makes it easy for novices and experts alike, to create and
publish animation on the World Wide Web.

You don't need to know any programming to create Liquid Motion animation. The program gives you basic building blocks that
you can use to create simple to advanced animation, depending on your experience level. Liquid Motion works on any browser
that supports Java on any platform. This includes Microsoft Internet Explorer browser version 4.0 and Internet Explorer 3.0. So, a
wide range of users can see Liquid Motion animations.

Shockwave technology
Shockwave from Macromedia, is the technology that allows users to deliver and experience interactive multimedia, graphics, and
streaming audio, on the World Wide Web.

Shockwave elements are created and played back with Shockwave Director, Shockwave Flash, Shockwave Authorware, and their
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players, which are plug-ins for Web browsers, including Microsoft® Internet Explorer browser version 4.0. Internet Explorer 4.0
includes the Shockwave Director and Flash players.

RealPlayer
RealPlayer is developed by RealNetworks and Macromedia. RealPlayer allows you to listen to RealAudio clips, watch RealVideo
clips, and view RealFlash animations, live and on demand in real time. They start playing right away rather than making you wait
until the entire file downloads.

QuickTime, from Apple Computer, Inc.,
Quick time is the technology that makes it possible for World Wide Web sites to feature audio and video clips. It allows site
builders to author digital audio and video files for their site, and it allows users to get the intended multimedia experience. With
QuickTime 3.0 and other streaming media tools, you can listen to and watch clips as soon as they start to download from a site,
rather than having to wait until the complete download. QuickTime 3 can play more than 30 video and audio file formats.

QuickTime runs on the Microsoft® Windows® 95, Microsoft Windows NT®, and Macintosh operating systems. Microsoft Internet
Explorer browser version 4.0 supports QuickTime video playback.
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WebBrowser
What is a Web browser?
All the information on the web and all the services that the Internet offers to you can be accessed through the web
browser.

A Web browser contains the basic software that you have to find, retrieve, view, and send information over the Internet.

The web browser will
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•

Allow you to browse through the content on the world wide web, where you can find a rich variety of text,
graphics, and interactive information.

•

Send and receive electronic-mail or e-mail messages world-wide almost instantaneously.

•

Read messages from newsgroups and forums about topics on which information and opinions are contributed
by users.

Web browsers
There are a number of web browsers available, which allow you to browse the information over the Internet. The most commonly
used web browsers are the Microsoft Internet Explorer and the Netscape Navigator. The other web browsers are Opera, Fortify,
Neoplanet, Ariadna, Cyberdog, Web Prowler, Slipknot, Hot Java etc ..

To start surfing on the net, once you install the web browser, you have to supply the URL of the web site
which you would like to visit.
A URL, or uniform resource locator, is the address of an Internet file. Usually it consists of four parts:
protocol, server (or domain), path, and the file name. Sometimes there may be no path or file name.
Here's an example:

http://www.Mybestnotes.com/index.php

In this http is the protocol, www.mybestnotes.com is the server or domain name and the index.html is the web page.

The best browsers enable you to

•

Fill out forms

•

Customize bookmarks or hotlists
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•

Save a browsing history

Browsers tips
Because of the rich content on the web sites, sometimes you may feel that the speed at which you are browsing is slow.
The following tips will help you to browse the net, effectively and efficiently.

To save time on the Web, you can

•

Stop or interrupt downloading.
Lengthy files can take a long time to access on the Web. Since hypertext links do not indicate the size of the file,
you may find yourself waiting several minutes for a resource. A browser that allows you to stop the process of
accessing a Web resource can be useful, if you find yourself pressed for time.

•

Turn off display of images
Images take significantly longer to display than text. If you are more interested in the information than the
pictures on a Web page, you may want to turn off the display of embedded images. Browsers that have this
feature enable you to access Web resources more quickly. Some of the latest browsers start showing text as
soon as they receive it, while filling in images gradually. This approach gives you the chance to decide whether
the Web page is useful before waiting for the images to appear on it.

•

Use multiple windows
Some browsers support multiple windows. This is a time-saving feature, because the browser can download a
file in one window while you are viewing a different file in another window or fill out forms.

•

Customise bookmarks or hotlists or favourite lists.
Keep a tag or book mark on the web sites that you visit frequently. This will save your time in typing the URL.
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•

Save a browsing history
Save your browsing history to quickly re-visit the pages that you have recently visited.

Browsers tips
To improve the efficiency of your browsing you may use the following options.

(Tip: The default browser is Internet Explorer, if you are using any other browser you will find similar options, but the
way the options are categorized may be different.)

How to display all Web pages faster?

How to display the previously viewed pages faster?

How to change the colours of the page?

How to display text in a different font and size?

How to add a page to your Favorite?

How to change your default home page?

How to save text and graphics from the Web?

How to add a page to your Links bar?

How to create a desktop shortcut to the current page?

How to return to a Web page you've already seen?

How to change the appearance of the toolbar?
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How to put the pages recently visited, in the cache memory?

How to display all Web pages faster?

1.On the View menu in the browser, click Internet Options.
2.Click the Advanced tab.
3.In the Multimedia area, clear one or more of the Show pictures, Play animation, Play videos, or Play sounds check boxes.
4.If the Show pictures or Play videos check box is cleared, you can still display an individual picture or animation on a Web page
by right-clicking its icon and then clicking Show Picture.
5.If the pictures on the current page are still visible after you clear the Show pictures check box, you can hide them by clicking the
View menu and then clicking Refresh.
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How to display the previously viewed pages faster?

1.On the View menu in the browser, click Internet Options.
2.On the General tab, click Settings.
3.To create more space to store pages temporarily, move the slider to the right.
4.To prevent Internet Explorer from updating pages in the Temporary Internet Files folder, click Never.
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How to change the colours of the page?

1.On the View menu in the browser, click Internet Options.
2.Change the settings, as needed

***** Copyright © EQuestionAnswers.com *****

Return to >>WebBrowser

How to display text in a different font and size?

1.On the View menu in the browser, click Internet Options.
2.On the General tab, click Fonts.
3.In the Proportional and Fixed-width font lists, click the fonts you want.
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How to add a page to your Favorite?

1.Go to the page you want to add to your collection of favorite pages.
2.On the Favorites menu, click Add to Favorites.
3.Type a new name for the page, if you want to.

To open one of your favorite pages, click the Favorites button on the toolbar, and then click the page you want to open.

To keep track of your favorite pages, you can organise them into folders. Click the Create In button in the Add to Favorites dialog
box.
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How to change your default home page?

1.Go to the page you want to appear when you first start the Internet Explorer.
2.On the View menu, click Internet Options.
3.Click the General tab.
4.In the Home page area, click Use Current.
5.To restore your original home page, click Use Default.
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How to save text and graphics from the Web?

When you see text or graphics on a Web page, that you like to refer to later, you can save them on your computer's hard disk.
Later, you can open the saved file and review it off-line.

To save a text or source file:
1.On the toolbar, click File, and then click Save As.
2.Click Save, to save the file

To save a graphic:
1.Right-click the graphic.
2.On the shortcut menu that appears, click Save Picture As.
3.Browse to the folder where you would like to save the file.
4.Click Save, to save the file.

To open a saved file, double-click it from the folder where you have saved it. Microsoft Internet Explorer will start automatically,
and your saved file will appear in the browser window.
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How to Add a page to your Links bar?

1.Drag the icon for the page from your Address bar to your Links bar.
2.Drag a link from a Web page to your Links bar.
3.Drag a link to the Links folder in your Favorites list. You can either drag it directly to the Favorites menu and then into the Links
folder, or you can drag it to the Links folder, when displaying your Favorites in the Explorer bar.
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You can also organise your links by dragging them to a different location on the Links bar.

Return to >>WebBrowser

How to create a desktop shortcut to the current page?

1. Right-click in the page, and then click Create Shortcut.

If the Internet Explorer window is not maximised, you can also create a shortcut by dragging a link from the Internet Explorer
window to the location you want, such as your desktop or a folder.

Return to >>WebBrowser

How to return to a Web page you have already seen?

There are several ways to return to a previously viewed Web page:
1. To return to the last page you viewed, you can click the Back button on the toolbar, or press the BACKSPACE key.
2. To see a list of the last few pages you visited, click the small down arrow beside the Back or Forward button. Then click the
page you want.
3.If you want to view one of the last five pages you visited in this session, click the File menu, and then on the list, click the page
that you want to go to. This list is started fresh every time you start the Internet Explorer.
4.To view more pages, including pages you visited in previous sessions, click the History button on the toolbar, and then click the
appropriate folder.

Return to >>WebBrowser

How to change the appearance of the toolbar?

1.You can move or resize the Address bar or Links bars by dragging them up, down, left, or right. You can even move them into
the menu bar.
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2.To make more room on your screen, you can hide the toolbar button labels. Just right-click the toolbar, and then clear the check
mark next to Text Labels.
3.You can hide the Address bar or Links section of the toolbar by right-clicking the toolbar, and then clearing the check mark for
each item you want to hide.
4.You can add items to the Links bar by dragging the icon from the Address bar or dragging a link from a page. You can
rearrange items on the Links bar by dragging them to a new location on the bar.
5.You can use smaller Microsoft Office-style toolbar buttons. On the View menu in a browser window, click Internet Options, and
then click the Advanced tab. In the Toolbar area, select the Small icons check box.

Return to >>WebBrowser

How to put the pages recently visited in the cache memory?

When you explore the Web, your browser keeps track of the pages you've visited and saves them on your hard disk so they'll load
faster when you return them. This saves your time and money because you can view the saved pages without being connected to
the Internet. The saved files, your "temporary Internet files", are stored in your disk cache.

When you browse, your disk cache sometimes fills up with files you no longer need. Here's how to empty your Internet Explorer
disk cache.
Select Internet Options from the View menu of your browser and click on clear history button on the General tab and then click on
yes button on Internet properties pop-up. Now click on OK button to close the window.

Return to >>WebBrowser

Return to >>Main Menu

Search Engines
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Why search engines?

The size of Internet is expanding day-by-day. Millions of new sites are added every day.

Searching for the required information in this ocean of information, is like searching a small needle in the haystack.

Searching through the vast amount of information on the Internet is a challenge. There is no central catalogue of
sources, no guarantee about the quality of the information, no uniform method of organizing it, and no all-purpose tool
for locating it.

There is a lot of valuable information on the Internet, split into bits and pieces. Assimilating all this is not easy.

But, don’t worry! There are various tools for finding the required information. These tools prepare catalogues and index
the content of the Internet.

Search engines are the tools that help us to search for the required information.

A search engine is a software that indexes and organises the Web sites.
Different search engines work in different ways.

A number of search engines are available today. You may use any one to search for relevant information. Different
search engines work in different ways and use different search algorithms. The search engines may give you different
set of sites, when you search for the same information.

How search engines work?

Some search engines rely on people to maintain a catalogue of Web sites or pages, some use software to identify key
information on sites across the Internet and some of them intelligently combine both types of service.
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Search engines
There are many search engines available, some of the popular search engines are Yahoo, Excite, Infoseek, etc..

No search engine can keep track of all the content of the Internet.

Even the major search engines such as Excite, Infoseek, Lycos, and Yahoo, will not provide you everything. (Some studies
indicate that even the top search engines find less than half of what's really out there!)

You can ask the computer to search for the desired information, using all the available search engines.

Here, we give in brief, the information about the some of the search engines, and how they work.

Excite
Excite is a hybrid search engine, it fulfils the traditional search engine definition. It is always visiting Web sites and cataloguing
them, using a software program. Excite also has a directory, a subsection of its catalogued sites, which have been reviewed by
people.

Infoseek
Infoseek's search engine has an extensive catalogue of sites. Infoseek has a directory too, which categorises sites
according to topics, using software. Some sites have been reviewed and are recommended.

Lycos
Like Excite and Infoseek, Lycos is a search engine with a directory, organised by subject. You can also search the Lycos
service "Top 5%," sites, considered by its reviewers to be among the top five percent of sites on the Internet.

Yahoo
This is actually a directory rather than a search engine. Humans compile and categorise the sites it searches. So one
may get fewer results. But Yahoo! makes it easy to search for sites by category and to continue your search using a
search engine, if you want to.
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Metacrawler
Rather than keeping its own database of web sites, Metacrawler conducts your search simultaneously on several search
engines, including Excite, Infoseek, Lycos, and Yahoo. This takes a little longer than using just one search engine, but
it's likely to yield a more comprehensive set of results.

Google
Clean, fast and focused, Google was an early breakaway from the heavy ‘portal’ searches. With the largest ever indexed
database containing over a billion pages and a search ranking system that is amazingly accurate, Google is the hands
down winner when it comes to quality of search result. When hunting for specific information, this is the search engine
to best. It also did very well in business searches and locating home pages, and had the best overall result across
categories. We can call it an Ideal

search engine .

Major search sites generally provide more than one search engine for finding Web sites. They also allow you to look up
information such as recent news stories, newsgroup postings, reference material (such as dictionary entries and maps),
and e-mail addresses, street addresses, and telephone numbers of business and individuals.

Guidelines for selecting a search engine

To search for a broad, common topic, such as "What is Internet?", use a search engine that tends to give you fewer
results of higher quality (usually the type that relies on people to catalogue sites, such as Yahoo).

To search for a specific but rare topic, such as information on a particular book or CD or even a food recipe, use a site
that is less discriminative but yields more results (usually the type compiled by a software program, such as Excite or
Altavista).

Tips for searching
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Use more than one search engine
No search engine indexes all Web sites and Web pages. So, if your first search doesn't produce the results you wanted, try
searching with at least one other searching engine.

Read the "About" page
Many search engines have a link that leads to detailed information about how the search engine compiles and searches through
information, and how to get the best results from it. Reading this page can save you a lot of time and headaches. Also, visit
search engine home page links with names like "How To," "Search Help," and "Advanced Search", for searching tips.

Get targeted results, by being specific
The more specific your search word, the more targeted your search results will be. If you search for the words Labrador retriever,
for example, rather than the word dog, your search will yield fewer sites, but they will be targeted to the type of dog that interests
you.

Get more results, by being general
If your search word is too specific, your search may yield few or no results. To get more results, try searching for a related word
that is more general.

Use Boolean operators such as AND, NOT, OR
The major search engines let you select whether to search for the exact phrase you typed, all the words in the phrase but not
necessarily together, any of the words in a phrase, and so on. A few search engines do not give you such options. In this case,
you can define the search yourself by adding one or more words or symbols to your search topic. The Boolean operator are AND,
OR, NOT and combination of all these.
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Get More Information in >>Complete Reference to Search Engines

Return to >>Main Menu

With that thought I end this discussion.
Warm regards,
Webmaster@mybestnotes.com
Updated on 06th June 2010
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